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Welcome to SmartCat Plus
SmartCat is a sophisticated disk cataloging system for Microsoft Windows. For information on its 
many and varied functions choose one of the options below:-

Evaluation Licence and Distribution Requirements

General Information
Keyboard Usage
Commands
Procedures
Processing Files
Customization
Problem Determination

New In this Release

This software is supplied as is without warranty or representation either express or implied 
with respect to the program or its documentation including their quality, performance, 
merchantability, or fitness for a particular purpose.

In no event will Oakley Data Services or any of its agents or assigns, or any organization 
distributing SmartCat Plus on its behalf be liable for direct, indirect, special, incidental, or 
consequential damages arising out of the use of, or inability to use the program.

All trademarks are acknowledged.
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This product is not public domain or free software. If you have not already purchased this product, 
you have the right to evaluate it for a period of 30 days from the date you initially install it. If you find 
that it suits your needs and you wish to continue to use it after the 30 day period you are required to 
purchase a fully licensed copy from Oakley Data Services or one of its agents. 

You also have the right, and in fact you are actively encouraged, to distribute copies of the evaluation
version of this product. You may assume you have our authority to distribute this product unless we 
explicitly tell you otherwise. It must, however remain in its original, unmodified state, and all its 
constituent files must be included. No-one may charge for the program itself, although a reasonable 
fee for the media used and copying costs is allowable.

You may not distribute copies of the licensed version of this product.
All rights not specifically granted here are reserved by Oakley Data Services.

This software is supplied as is without warranty or representation either express or implied with 
respect to the program or its documentation including their quality, performance, merchantability, or 
fitness for a particular purpose.

In no event will Oakley Data Services or any of its agents, or assigns, or any organisation distributing
SmartCat Plus on its behalf be liable for direct, indirect, special, incidental, or consequential 
damages arising out of the use of, or inability to use the program.

All trademarks are acknowledged.



General Information
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If you are like most users its probably a forlorn hope to suggest that you read the help file from start 
to finish before you dive in, but can we suggest that before you proceed to catalog all your floppy 
disks or CD-ROMs that you at least read the next section about the best way to organize your disks, 
and the section on

customizing SmartCat
to work with various archive extraction programs.

Categorising your disks and CD-ROMS
Getting the best from SmartCat needs some thought about the best way to organize your collection 
of disks/CDs. Even if you only have a few floppy disks or CDs now, it won't be long before your 
collection grows substantially. Whilst SmartCat doesn't have any particular limit to the number of 
disks it will catalog in a single catalog (apart from the amount of memory you have, and the amount 
of disk space available to store the catalog) it probably isn't sensible to keep all your disks cataloged 
in one catalog. We would suggest you catalog your disks based on their "category". Some of your 
disks will have come from Software Manufacturers, such as your DOS and Windows distribution 
disks, and you are never likely to write new or amended files to them. Others will be disks that have 
come from Shareware libraries, and again writing to them would be unlikely. Others may have come 
from magazine cover disks, and would form a logical third category. Then there will be those that you
use as working disks, and perhaps others you keep customer data/work on.

We would suggest that you divide your catalogs based on the categories you consider most sensible 
for your particular way of working. SmartCat supports the merging of catalogs for searching and 
reporting purposes, so you can always simulate a single catalog if you need to.

Considerations for CD-ROMs
Even more thought might be required when it comes to CD-ROMs, because of the vast amounts of 
data they can contain. The best course of action really depends on the sort of CD-ROMs you are 
dealing with. If a CD-ROM contains a vast number of "smallish" files, like a collection of Clip-Art, then
the best approach might be to put it in a catalog of its own. Similarly large collections of shareware 
can simply overwhelm and individual catalogs might be the approach to avoid extended processing 
times. You can of course always merge multiple CD-ROM catalogs if you need to for searching 
purposes.    Also consider the time it might take to catalog a CD-ROM, depending on what you are 
asking SmartCat to do. If every file on the CD-ROM is zipped then SmartCat Plus is going to have to 
read pretty much ALL the data on the CD-ROM to catalog it if you want it to analyze .ZIPs, and that 
can take many minutes because CD-ROMs are not the fastest of devices.

If the Rom contains 650Mb of data, and it has a data transfer rate of 150K/Sec (most say they do, 
but they don't), then it will take at least 72 minutes just to read the data. At least you can relegate 
SmartCat to the background while you get on with something else, and you usually only do it once, 
because the data on CDs doesn't change.



Likewise if you install a lot of extension DLLs then the catalog time may extend if they have 
significant processing to do.

Labeling your Disks
SmartCat Plus can print disk labels for you, using any label stock you have to hand, or you can 
simply write the volume number that SmartCat allocates the disk when you catalog it onto the original
label with a felt tip pen or similar. If you then store your floppies in numerical order within category it 
will be a simple task to find any one of them. Alternatively, most stationers sell small, nicely printed 
stick-on labels in ascending numerical sequence which you can stick discretely over a corner of the 
original label.



Customisation Details
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SmartCat can be customised to suit your needs, and the way you like your system to work. There are
several areas where you can customise SmartCat, including the way it performs pre-catalog virus 
scanning, the way it performs extraction from archives, and what effect pressing any of the "User" 
buttons in the Process File dialog box has. All customisation is undertaken by modifying the 
SMARTCAT.INI file which is distributed with the product. The SMARTCAT.INI file can be found in 
your WINDOWS directory.

Pre-Catalog Virus Scanning
In your SMARTCAT.INI file you will find the following line:-

ExSCAN=SMCATDOS.BAT SCAN %d /NOMEM
The detail after the = sign is the command SmartCat will issue to cause a virus scan of the disk. The 
%d parameter will be replaced with the drive designation (i.e. a:) for the drive to be used for 
cataloging. As delivered SmartCat will call the supplied SMCATDOS.BAT file which in turn will call 
the McAFee Scan program with the memory checking option disabled. Note that the SCAN program 
is not supplied as part of SmartCat, but is available from all good shareware sources. If required you 
can modify this command to suit your needs, perhaps by calling an alternative virus scanner.

Archive Processing
In your SMARTCAT.INI file you will find the following 5 lines:-

ExZIP=SMCATDOS.BAT PKUNZIP -O
ExLZH=SMCATDOS.BAT LHA E /C
ExARC=SMCATDOS.BAT ARC-E
ExPAK=SMCATDOS.BAT PAK E
ExARJ=SMCATDOS.BAT ARJ E
Each of these lines represents the beginning of the command that SmartCat will issue to invoke the 
relevant archive extraction program. SmartCat appends the archive file name and target path name 
as required. If you wish you can modify these commands to more suit your way of working. For 
example you may wish to use the ARC program to extract "ARC" files rather than the "ARC-E" 
program which is the default. If so, modify the ExARC line to read "ExARC=SMCATDOS.BAT ARC 
E". Similarly, the commands above assume the extraction programs can be found somewhere in a 
directory in your PATH . If this is not the case you may wish to add drive/directory information to 
these commands. Note that the archive extraction programs are not supplied as part of SmartCat, 
but all are freely available as shareware from good shareware sources.

Defining "User Buttons"
In your SMARTCAT.INI file you will find 8 pairs of the following type of lines:-

User1Btn=&View



User1Cmd=Notepad.exe %f
The UsernBtn= line defines, for each user button, what will appear on the button face. The & 
immediately preceeds the character which will become the button's "hot-key" (although there aren't 
many left to choose from, and if you duplicate one that already exists in the dialog box the original 
will take precedence). If the file is actually in an archive, SmartCat will automatically add the 
character X to the start of the button text (and will extract the file first if you push the button!) 

The UsernCmd= line defines what command will be issued when the button is pressed. In the 
command the following characters can be used which will be replaced by SmartCat before the 
command is issued:-

· %f SmartCat will insert the name of the file, including its full pathname.
· %t SmartCat will insert the target pathname selected in the process file dialog box.
· %n SmartCat will insert the filename, excluding its path.
· %p SmartCat will insert just the path to the file, excluding the filename.
For example, assuming you had a super-wizzo editor called WIZZO, and you wanted to modify user 
button 4 to call it, you would need something along these lines:- 

User4Btn=&Wizzo 
User4Cmd=WIZZO %f 

Note that as delivered the first user button has been set up as &View, and it calls the NOTEPAD 
program. The second user button has been set to call the McAFee virus scanning program SCAN via
the SMCATDOS.BAT interface batch file. All the other user buttons are set up to call the WRITE 
program. 



Keyboard Usage

Copyright © 1994 Oakley Data Services
Call +44 (0)1270 759739, Fax +44 (0)1270 765272, CIS 74774,1347

The following keyboard shortcuts are supported:-
File Menu:-
· Open Catalog Alt + O
Edit Menu:-
· Copy to Clipboard Shift+Ins
Maintain Menu:-
· Add Disk Ctrl + A
· Delete Disk Ctrl + D
· Update Disk Ctrl + U
· Renumber Disk Ctrl + R
· Modify Comment Ctrl + C
· Process File Enter
View Menu:-
· Volume Contents Ctrl + V
· Internal Files Ctrl + I
· Statistics Ctrl + S
· Merged Catalog Listing Ctrl + M
Search Menu:-
· Simple Search Alt + S
· File Comment Search Alt + C
Help Menu:-
· Contents F1



Commands
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File Menu
Edit Menu
Maintain Menu
View Menu
Search Menu
Options Menu
Label Menu
Window Menu



File Menu
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New Catalog
Selecting New Catalog clears the current Catalog. If there are any unsaved changes a prompt is 
issued to allow the catalog to be saved if required.

Open Catalog
Selecting Open Catalog(s) presents a dialog box from which one or more catalogs stored on disk can
be loaded. If a catalog is currently open and    there are any unsaved changes a prompt is issued to 
allow the current catalog to be saved if required. If only one catalog is selected in the dialog box then
it is simply loaded. If two or more catalogs are selected then the first is loaded and the rest are 
merged with it.

Save Catalog
Selecting Save Catalog saves the current catalog to disk. The catalog remains open and you can 
continue to work on it. SmartCat uses an intelligent saving technique and will not delete the old copy 
of a catalog until it is sure it has correctly written the new one.

Save Catalog as
Selecting Save Catalog As presents a dialog box in which specifications of where the current catalog 
should be saved can be entered. Note that you cannot save a merged catalog.

Merge Catalog
Selecting Merge Catalog presents a dialog box in which one or more catalogs stored on disk can be 
specified. Those catalog(s) are then merged with the current catalog. There are certain restrictions 
when the current catalog is the result of one or more merge operations. For a more detailed 
description of these restrictions refer to the section Merged Catalogs . Note that there is a limit of 255
on the number of consecutive merge operations

Printer Font
Allows you to select the font to be used when printing reports. Note this does not affect the fonts 
used when printing labels.

Printer Setup
Allows you to select the printer to use, and presents the standard Windows dialog for configuring the 
printer.

Print
Produces a listing of the contents of the Window that currently has the focus.



Exit
Selecting Exit will terminate the program. If there is any unsaved data a warning will be presented 
and the option to save the data given.



Edit Menu
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Copy
Selecting the Copy command will copy the contents of the current front window to the Windows 
Clipboard . If for example a Disk Window, containing details of the contents of a cataloged disk, was 
currently the front window then those details would be sent to the Clipboard. The data will be placed 
on the Clipboard in the same sort order that the data displayed in the window is in. For details of how
to modify the sorting order refer to the options menu command.

Find
Searches for a text string within the window that currently has the focus.

Find Next
Repeats the last find command, starting from the currently selected record.



Maintain Menu
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Add Disk
 Selecting the Add Disk command causes the Add Disk Dialog Box to appear. The dialog box has 
options for specifying :-

· The Drive to use to catalog a disk. Only those drives present on your system are displayed. You 
can choose whichever you wish

· BulletWhether to analyse the internal contents of ZIP,ARC,ARJ,LZH and PAK format archive 
files. Each archive type is presented as an on-off toggle option, and clicking on it with the mouse 
will switch its state. We would expect you would usually want to select these options, but there 
may be times when a corrupt archive may cause problems and it will be necessary to prevent 
SmartCat from attempting to read it (although if it is defective it may be more sensible to delete it 
or fix it!).

· Whether to permit or query unlabelled disks. If you select query then an attempt to catalog a disk
which is unlabelled produces a further dialog box, from which you can select to label the disk, 
allow it to be cataloged without a label, or cancel the cataloging operation. Choosing to permit 
unlabelled disks causes the disk to be cataloged as [unlabelled]. Allowing the cataloging of 
multiple unlabelled 
disks slightly increases the risk of processing an incorrect file

· The Reporting Mode required. If set to "verbose" each file encountered is reported in the 
message area at the bottom of the dialog box. If set to quiet no files are reported. If set to auto 
files are reported when cataloging disks on drives "a" and "b", but not otherwise. Updating the 
message area for each file can slow down cataloging a hard drive quite considerably, but can be 
very useful for problem determination purposes.

·  If a preliminary Virus Scan is required. If set to "yes" a Virus Scanning program will be called 
before the disk is cataloged. The choice of virus scanning program is user configurable, and 
further details can be found in the customization options section.

· Whether to try to extract comments automatically from .ZIP, and .ARJ archives, and whether to 
attempt to detect Norton/4DOS comments (If you don't know what they are you needn't worry 
about them).

· The comment text you want associated with the disk.
Clicking on "ADD" then causes SmartCat to read the volume label of the disk. If an unlabelled disk is 
found and the Unlabelled disk query option was selected the option to continue, label the disk, or 
cancel the process is given. The current catalog is then searched for a disk with a duplicate label, 
and if one is found the options to continue or cancel are presented. Assuming continue, or no 
duplicates, the directories on the disk are read and each file found is cataloged. If requested, the 
contents of Archive files are also cataloged, and comments are automatically extracted 
from .ZIP, .ARJ and Norton/4DOS files. 

When the disk is cataloged the dialog box remains on screen, ready for another disk to be inserted 
and cataloged. When all disks have been cataloged the "DONE" button should be selected to end 
the process.



Delete DIsk
Selecting the Delete Disk command removes from the catalog the disk which is currently selected in 
the    catalog window . A confirmation box is presented giving you a final chance to confirm the action.

Update Disk
Selecting the Update Disk command displays the same dialog box as in the "Add Disk" command. 

Having chosen the required options and pressed the "ADD" button, the volume label of the disk in 
the drive is compared to the catalog record for the disk which is currently selected in the catalog 
window . Assuming the labels match the disk is then processed as for the "Add Disk" command, and 
the records for the disk replace those originally in the catalog. Any comments associated with 
unchanged files are preserved however.

Renumber DIsk
Selecting the Renumber Disk option allows you to change the catalog number of the disk which is 
currently selected in the catalog window . A dialog is presented which allows you to enter a new 
number. Providing the number you select does not already exist it will replace the current volume 
number. The volume number must lie in the range 1 - 9999.

Modify Comment
Selecting Modify Comment allows you to add, delete or change the disk comment associated with 
the disk which is currently selected in the catalog window , or the file comment associated with the 
file which is currently selected in the Disk window or Search window . A dialog is presented which 
allows you to enter a new comment. If you wish to delete an already existing comment simply delete 
all the characters by pressing the backspace key when the dialog first appears and then select "OK".

Process File
Selecting the Process File option displays a dialog box which allows you to specify actions to take 
against the file which is currently selected in a search window or a disk window . For further 
information see the section on processing files . Note that selecting this menu command is 
equivalent to double-clicking on an file in a search or disk window.



View Menu
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Volume Contents
Selecting the Volume Contents command will create a new disk window which will display the 
contents of the currently selected volume in the catlog window.

Internal Files
Selecting the Internal Files command will create a new search window which will display the contents
of the currently selected archive or custom-DLL processed file in the disk window or search window 
which currently has the focus . If the currently selected file is not an archive and has not been 
processed by a Custom DLL then the menu option will not be available.

Statistics
Selecting the Statistics command will display a dialog box which will give statistical details of the 
catalog window or disk window or    search window which is currently has the focus. 

Merged File Listing
Selecting the Merged File Listing command will display a dialog box which will give a cross-reference
of the the catalog names in the catalog window to the full path names of the catalog files they are 
associated with. This option is only available after a catalog merge has been undertaken.



Search Menu
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Simple Search
Selecting the Simple Search command will display a Dialog Box in which you can enter one or more 
filename patterns to search the catalog for. The search argument you enter can include the standard 
DOS wildcards * and ?. Multiple search arguments should be separated by a space. The results of 
the search will appear in a search window , from where you can process any of the resulting files.

File Comment Search
Selecting the File Comment Search option presents a dialog box in which you can enter up to 3 text 
strings to search the recorded file comments for. The text strings are not case sensitive. They can be 
combined on an and or an or basis by use of the radio buttons in the bottom left corner of the dialog 
box. The dialog box "remembers" the last few search arguments entered during a SmartCat session, 
and they 
can be recalled by use of the drop down arrows at the right. The results of the search will appear in a
search window, from where you can process any of the resulting files.



Options Menu
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Catalog Sort Order
Selecting the Catalog Sort Order command presents a further sub-menu which allows the 
specification of the sort order required for the catalog window . If the catalog window currently has 
the focus then the new sort order will take effect immediately. If another window has the focus, then 
the new sort order will take effect when the catalog window gains the focus.    The specified sort order
also affects the order in which entries will be printed or copied to the Windows Clipboard .

Disk Sort Order
Selecting the Disk Sort Order command presents a further sub-menu which allows the specification 
of the sort order required for the disk window(s) . If a disk window currently has the focus then the 
new sort order will take effect immediately. If another window has the focus, then the new sort order 
will take effect as disk window(s) gain the focus. The specified sort order also affects the order in 
which entries will be printed or copied to the Windows Clipboard .

Search Sort Order
Selecting the Search Sort Order command presents a further sub-menu which allows the 
specification of the sort order required for the search window(s) . If a search window currently has 
the focus then the new sort order will take effect immediately. If another window has the focus, then 
the new sort order will take effect as search window(s) gain the focus.    The specified sort order also 
affects the order in which entries will be printed or copied to the Windows Clipboard .

Show/Hide Internal Files (Disk Windows)
Selecting the Hide Internal Files (Disk Windows) or Show Internal Files (Disk Windows) commands 
changes the display style of Disk Windows, by either displaying or not displaying those files which 
are internal components of another file (i.e. the internals of Archives such as .ZIPs or .ARJs, or any 
internal filenames provided by custom extension DLLs such as the internal files in a DOS6 backup, 
or the internal content of BookManager<TM> bookshelves).

Separators
Selecting the Separators command allows the specification of the type of lines to use to separate 
each entry in Catalog, Disk and Search Windows in each of the different display modes. The choices 
presented are for no lines, dotted lines, dashed lines or solid lines.

Switch Display Mode
Selecting the Switch Display Mode option allows you to change the mode of display for the dates and
times etc.), to short data (just name, path and drive), to comment (just name and comment text (if 
any)), to data and comments (all data and comment text (if any)) spread over two lines. Note that you
can also cycle through the display modes of the window that has the focus by ensuring the mouse 
pointer is over the window and clicking the right mouse button. 





Label Menu
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SmartCat's labelling functions depend on the concept of a "Label Stack". As you catalog disks with 
the "Stack Label" option checked, or when you select one of the "Add to Label Stack" options 
described below, SmartCat will add to the "Label Stack" the details required to subsequently print the
labels.

Clear Label Stack
Selecting the Clear Label Stack command clears the records for any previously stacked disk labels. 
The label stack is also cleared when a catalog is closed, or the program is terminated.

View Label Stack
Selecting the View Label Stack command presents a Dialog which displays the current contents of 
the label stack. From this Dialog you can delete individual disk labels that you no longer wish to print.

Stack Selected Disk
Selecting the Stack Selected Disk command adds to the label stack details of the disk which is 
currently selected in the Catalog window .

Stack All Disks in Catalog
Selecting the Stack All Disks in Catalog command adds to the label stack details of the all the disks 
which are currently in the Catalog window .

Stack Manual Label
Selecting the Stack Manual Label command present a dialog from which you can manually enter 
details of a label you want added to the label stack, and signify how many copies of the label you 
want printed.

Print Stacked Disk Labels
This option presents a dialog which allows you to detail the dimensions of the label stock you intend 
to use, how many label positions on the page to skip before beginning to print the labels, and what 
fonts to use for the various parts of the labels. The dimensions used in the dialog are determined 
from the International Settings specified to the Windows Control Panel.



Window Menu

Copyright © 1994 Oakley Data Services
Call +44 (0)1270 759739, Fax +44 (0)1270 765272, CIS 74774,1347

The Window menu subcommands implement the normal window management commands for MDI 
windows , with some extensions particularly relevant to SmartCat. For further information about 
general window management refer to your Windows documentation.

Cascade
Selecting Cascade re-arranges all non-minimized windows in an overlapping fashion.

Tile
Selecting Tile re-arranges all non-minimized windows in a tiled fashion, where all the space in the 
client window is used, but no windows overlap each other.

Tile On Top
Selecting Tile on Top re-arranges all non-minimized windows in a tiled fashion, where all the space in
the client window is used, but no windows overlap each other. The windows are arranged with 
priority given to a horizontal arrangement.

Arrange Icons
Selecting Arrange Icons causes any minimized (iconised) windows to re-arrange themselves neatly 
at the bottom of the client window.

Minimize All Windows
Selecting Minimize all Windows causes all open windows to assume the minimized (iconised) state.

Restore All Windows
Selecting Restore all Windows causes all minimized windows to assume the normal state.

Close All Search Windows
Selecting Close all Search Windows causes all    search windows (minimized, maximized or normal) 
to close.

Close All Disk Windows
Selecting Close all Disk Windows causes all    disk windows (minimized, maximized or normal) to 
close.

Close All Windows Except Catalog
Selecting Close all Windows except Catalog causes all open windows (except the catalog window ) 



to close. You cannot close the catalog window.



Procedures
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Select the required procedure
Loading a catalog file
Saving a catalog file
Merging Catalogs
Cataloging Disks
Updating Cataloged Disks
Deleting Disks from the catalog
Renumbering Disks
Displaying Disk Contents
Investigating archive files
Viewing statistical information
Searching the catalog
Processing files
Copying information to the clipboard
Sorting file information
Managing the windows



Processing Files
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Once you have located the file(s) you are interested in, either in a disk window or a search window 
you can process the file in a number of ways. Having put the disk in question into the drive (unless 
the file is on a hard disk) double clicking on the file name will present a dialog box from where you 
can specify what action you wish to take. 

The dialog box that is presented details at the top the name of the file, the number of the disk it is on,
the volume label (if it has one), and the default drive in which it expects to find it.    To the right of the 
dialog box is a list box showing the available drives on your system, and you can select an 
alternative drive from which to process the file if desired. 

To the left of the dialog box is another list box, and just above it the words "Target Path:-". The target 
path defines where any action which creates a further file or files will place those files. For example, 
the "Explode" option, which extracts all the files from an archive, will place the resultant files as 
specified by the "Target Path" specification. You can change the target path specification by use of 
the list box. The target path you specify is remembered from session to session. 

Slightly to the right of the centre of the dialog box are two on/off toggle options. Minimize on Use, if 
checked, causes SmartCat to shrink to an icon if another program is launched by use of the Run or 
Process buttons. Confirm Deletes, if checked, issues a warning before any destructive operation is 
undertaken on any file.
 
Towards the bottom of the Dialog Box are 16 further buttons. The first 9 provide a variety of options, 
and are enabled and disabled as appropriate for the type of file selected. If the selected file is part of 
an archive, the text of some of the buttons will change to be preceeded by an "X" signifying that the 
file will first be extracted from its archive to the target path before the action is undertaken.

· Delete will attempt to delete the file.
· Rename will attempt to rename the file.
· Copy will attempt to copy the file to the specified target path.
· Move will attempt to copy the file to the specified target path, and then delete the original.
· Run (which is only enabled if the file is executable), will attempt to execute the file.
· Process (which is only enabled if the file is associated with a particular program (use the File 

Manager File | Associate option to associate files to programs) - see your Windows 
documentation) attempts to launch the associated program with this file as its input.

· Extract attempts to extract this file from the archive it is in to the target path. This option is only 
enabled if the file is in an archive

· Explode attempts to extract all the files from this archive to the target path. This option is only 
enabled if the file is itself an archive.

· Print attempts to print the file to the current Windows printer
· The last seven buttons are user-definable. For more information see the customization options 

section.



Problem Determination
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SmartCat has gone through a thorough testing process, but like any complex piece of software there 
may be the odd bug still lurking. 

SmartCat also depends to some extent on the integrity of the data (i.e the disks, and the files 
thereon) that are presented to it to catalog.

If you discover a problem there are some things you can do to help narrow down the cause:-
If the problem occurs while cataloging a disk first determine if the disk is actually readable by the 
DOS DIR command (or the Windows File Manager). If they can't read it, it is almost certain the 
Directory Structure is corrupt. If there is no obvious problem try running the CHKDSK command 
against the disk in question (refer to your DOS documentation - the usual command is CHKDSK a: to
check the disk in drive "a") to see if there are any structural problems. If the disk can be read OK by 
a DIR command and the Windows File Manager, and CHKDSK suggests no problems, try cataloging
the disk again with SmartCat but having turned OFF all the archive analysis and auto-comment 
checkboxes. If SmartCat can now cope with the disk it is almost certain that one of the archive files 
on the disk is corrupt. A process of elimination, together with careful observation of the message box 
in the Add Disk Dialog box should enable you to narrow the problem down to a specific file. Once you
have determined which file causes the problem try to process it with its native utility and produce a 
list of the files the archive contains. If this also fails you don't have many choices, either attempt to 
repair the archive (some archives, like ZIP files, have a matching repair utility (PKZIPFIX)) or try and 
extract what you can before you scrap it.



New In this Release

Copyright © 1994 Oakley Data Services
Call +44 (0)1270 759739, Fax +44 (0)1270 765272, CIS 74774,1347

There have been no functional enhancements to this software since release 1.6. The only changes 
have been to contact information and ordering details.



Ordering SmartCat Plus

Copyright © 1994 Oakley Data Services
Call +44 (0)1270 759739, Fax +44 (0)1270 765272, CIS 74774,1347

You can access an order form either from the Help menu, or by pressing the "Order Form" button on 
the introductory screen. There are full contact details and prices on the order form.



Order Form - SmartCat Plus

Call +44 (0)1270 759739
Fax +44 (0)1270 765272
CIS: 74774,1347

You can print this order form by using the "Print Topic" option from the "File" menu.

You will receive:-

· A copy of the latest registered version of SmartCat Plus V1.X. Whilst we always try to ship as 
quickly as we can, by Air Mail if outside the UK, please allow 21 days for delivery.

· Shareware versions of some of our other software, including at least Smart Address - a very 
sophisticated Address Book/Mailing List Manager that was a finalist in the 1995 Ziff-Davis 
Summer Shareware Awards, and SmartDoc - a Windows Help File printing/Text extraction utility, 
plus whatever else we have that will fit on the disk.

We can accept your order by mail, E-mail, Fax or Phone. Unless otherwise requested we ship a 3.5" 
disk.

Send your order to:-
Oakley Data Services,
3 Oakley Close,
Sandbach,
Cheshire CW11 9RQ,
England.

Please send me __ registered copy(s) of SmartCat Plus..

Price :- £23.50 Pounds Sterling.
(In the EEC this is made up of 20 Pounds, plus VAT @17.5%, no charge for shipping. In the rest of 
the world this is made up of 20 Pounds, plus 3.50 Pounds Air-Mail Shipping + Handling).

(As of July 1995 the exchange rate was approximately 1.6 U.S. Dollars to 1.0 Pound Sterling. When we charge your credit 
card the card company will convert the cost to your local currency at the rate then prevailing and the sum will appear on your 
bill in your local currency.)

Total Price : .......................
I enclose a cheque / wish to pay by MasterCard / Visa / Amex (delete as applicable)

(Note: We can only accept cheques payable in the UK drawn in Sterling.)
Credit Card Details:-
Name as on card:-
Card Number:- 
Expiry Date:-



Please send the registered version to:-
Name:
Address:

Post/Zip Code:                                                Day Time Tel. No.

You can also contact us by:-
Phone:+44 (0)1270 759739; FAX: +44 (0)1270 765272;
Compuserve: 74774,1347
Internet: 74774.1347@compuserve.com ,
or via Section 4 of the UKSHARE forum on Compuserve.
or at http://www.smartcode.com

It would also help us if you could tell us where you got the original SmartCat from:-

And any suggestions you have for enhancements:-



Registration Form USA

Call 801 295-1890
Fax 801 299-1781

You can print this order form by using the "Print Topic" option from the "File" menu.

Send your order to:-
Insight Software Solutions
P.O. Box 354,
Bountiful, UT 84011-0354

Or Call 801 295-1890
Or Fax 801 299-1781
Or CompuServe:    71672,3464

Please send me __ registered copy(s) of SmartCat Plus V1.x.
Price Per Copy:-

Price                          $29.95 
Utah Residents add Sales Tax   $ 1.83 
Shipping by First Class Mail   $ 3.00
       --- or ---
Priority or Int'l shipping     $ 5.00
-----                          ------
Total                          $       
-----                          ------
All Prices are in US Dollars.

I enclose a check / wish to pay by MasterCard / Visa / Amex / DIscover (delete 
as applicable)

Credit Card Details:-

Name as on card:-

Card Number:-

Expiry Date:-

Please send the registered version to:-

Name:

Address:



Telephone Number.

It would also help us if you could tell us where you got SmartCat Plus from:-

And any suggestions you have for enhancements:-






